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ABSTRACT

Transportation agencies use many computer tools for managing infrastructure.  Engineers in

operating divisions at the lower end of the organizational hierarchy choose a variety of tools to meet their

specific needs.  Managers at the top of the organizational hierarchy want a uniform “enterprise” database

system that provides them direct access to agency-wide data.  Frequently, these two different approaches

at different levels cause inefficiencies in the agency.  This study was conducted to determine if

efficiencies could be gained through the process of standardizing data storage mechanisms to permit

diversity at the operating level while maintaining data compatibility for aggregation at higher levels in the

organization.

A needs assessment regarding pavement inventory and maintenance scheduling conducted at the

regional level provided the information for developing a computer-based tool for operations.  The needs

at headquarters for aggregating data were accommodated by exposing regional data in standard database

(.dbf) formats.  A variety of visual development tools were considered for the project.  Borland Delphi

was selected because it provides satisfactory connectivity for enterprise as well as local database back-

ends, it provides a powerful development language (object Pascal) for engineering algorithms, and it

provides an exceptionally good Integrated Developers Environment.

The Pavement Preservation Prototype software consists of three coordinated sections: Pavement

Treatments, Paint Treatments, and Maintenance Management Quality Assurance.  Each section was

provided with a custom Graphical User Interface in conjunction with a standard database back-end. 

Because the data were converted and exposed in a standard format, straight forward GIS analyses could

be applied.  Examples provided for each of the three prototype sections demonstrate the advantages of

standardizing regional data.
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PAVEMENT PRESERVATION SYSTEM
CONVERSION AND ENHANCEMENT PROTOTYPE

Project Objectives

1. Needs assessment at the regional level: Pavement inventory and scheduling needs at the regions

will be assessed. The regions are the operating level in the pavement information systems

hierarchy. All data collection and primary analysis are conducted in this level. Hence a system

that aids in this process must be developed. The primary attribute of such a system should be

user-friendliness. Another desirable feature would be to develop a system that encompasses

existing pavement preservation methodologies.

2. Needs assessment at the headquarters level: Headquarters is the level where all regional

pavement databases are aggregated and statewide data analysis is facilitated. At any given time

the regional databases must be accessible to the headquarters. The model should allow retrieving

data from different data sets in an efficient manner.

3. Develop architecture strategy: This objective entails fulfilling the needs at the regional level and

headquarters level. Objectives at this level would include data concurrency and multi-user access.

Data concurrency ensures that data at both the regional and headquarters level are the same while

preserving data integrity. Multi-user access allows multiple users to access the same data

simultaneously. This would also prevent multiple copies of the same data. 

4. Develop prototype applications: Prototypes must be developed for the pavement databases. Data

structures will be defined for storing data appropriately. The application should be designed to

ensure smooth transition between current practices and proposed practices. Demonstrate

prototype: The prototype will be tested to demonstrate the pros and cons of the approach and to

provide insight for implementation.
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Development Tool Selection

Leading development tools for information systems were reviewed to insure that state-of-the-art

technology would be used for the prototype. The following three terms are used by the industry and

throughout this report:

1. Back-end applications: The back-end application is where the data reside.  It also is 

known as the server; any computer process providing services to the client. The server

processes provide background services for the client process.  At one end of the spectrum

are large enterprise database servers, such as Informix and Oracle.  At the other end of

the spectrum are local databases such as Access and Paradox.  Microsoft SQL Server

capabilities lie somewhere in between.

2. Front-end applications: The end-user usually interacts with the client process. The client

is any computer process that requests services from the server. The client also is known

as the front-end application. Modern software products for the development of the front-

end commonly are referred to as “Visual Development Tools.” The current principal

competing products on the market are: Borland’s Delphi, Microsoft Visual Basic, Sybase

PowerBuilder, and Symantec Visual Cafe.

3. Middleware applications: Middleware is any computer process through which clients and

servers communicate. The middleware is made up of several layers of software that aid

the transmission of data and control information between the clients and the servers. The

communications middleware usually is associated with a network. All client requests and

server replies travel through the network in the form of messages that contain control

information and data.

Microsoft Component Object Model (COM) and the Object management Group Common Object

Request Brokered Architecture (CORBA) are competing architectures for addressing the problem of how

to define, construct, and deploy software elements that comprise complex systems.  Both architectures
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attempt to achieve database server independence by allowing front-end applications to access data from

multiple server databases without the need to write separate specific code for each database.  CORBA

implementations support a wider range of languages and platforms than COM. In contrast to COM,

CORBA was designed specifically for distributed systems. However, COM and CORBA seem to be

converging toward a consensus industry standard.

State-of-the-art visual development tools are used for developing middleware and for developing

the front-end applications.

Evaluation of Development Tools

Visual Development Tools

Visual development tools are used for the development of front-ends and middleware.  A World

Wide Web search was conducted to gain current evaluations of the principal visual development tools:

Borland’s Delphi, Microsoft Visual Basic, Sybase PowerBuilder, and Symantec Visual Cafe.  The

following six sites were selected in an attempt to provide a balanced summary:

• PC Magazine (www.zdnet.co.uk/pcmag/labs/1999/04/visual/004.html), which contains

the most up-to-date, in-depth, independent comparative evaluation that we could find.

• BYTE Magazine (www.byte.com/art/9611/sec12/art6.htm), contains an independent

comparison of Delphi, Visual Basic, and PowerBuilder.

• Microsoft (www.microsoft.com) because Microsoft produces Visual Basic. Its web site

contains an in-depth comparative evaluation of Visual Basic, Delphi, and PowerBuilder. 

The evaluation was prepared by NSTL, Inc.

• Sybase (www.sybase.com/products/powerbuilder/gigaart.html), which produces

PowerBuilder. Its web site contains a cursory comparison of PowerBuilder and Visual

Basic.
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• Borland (www.borland.com/delphi/papers/delvspowr/delvpowr.html), which produces

Delphi. Its web site contains an in-depth comparison of Delphi and PowerBuilder.

• Symantec (www.symantec.com/vcafe/index_reviews.html), which produces Visual Cafe.

PC Magazine

This section reviews the evaluation of visual development tools published by PC Magazine. This

is summarized in greatest detail because it is the most in-depth independent comparative evaluation

available at the time that this study was conducted.

• Value for Money: Though Delphi and Visual Basic were close in terms of pricing and

features, Delphi achieved higher usability and features scores as compared to Visual

Basic and PowerBuilder.

• Help Information: Delphi and Visual Basic code prompts and online help were

straightforward. PowerBuilder suffered from more erratic help information.

• Satisfaction: This index illustrates the consistent qualities of the products tested. Visual

Basic and Delphi both achieved high scores on this index. PowerBuilder’s confusing

interface and lack of examples affected tester’s perception of the product.

• Form Design: The testers found that creating Delphi forms was simple. Visual Basic also

scored high, but faced some criticism for its time-consuming process of changing

component properties. PowerBuilder received mixed reactions. Some features got an

excellent rating, such as the ability to preview the form without having to run the project.

However some features could be awkward for new users since the interface and

associated help files don’t make it clear where to find controls and tools.

• Reading from a database: Testers were asked to connect forms to a single table DBF

database containing 21 columns and 8,400 rows of data.  Delphi’s database wizard

simplified the procedure, contributing to the product’s overall productivity scores.
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Making the initial connection between the database and its associated form was more

awkward in PowerBuilder. Lack of good help affected PowerBuilder’s scores in all

usability indices. However, once the databases were incorporated, PowerBuilder was

found to have one of the strongest set of tools for database related applications. Options

for creating reports and labels were appreciated.

• Adding event code: Delphi automatically added code into the project. This reduced the

amount of code creation that testers had to complete. However lack of comments for such

generated code hampered debugging programs. On the other hand, PowerBuilder

required manual operations to carry out many tasks automated in most other packages. 

• Compiling and debugging code: Testers found debugging Delphi source code difficult

due to much of the code being generated automatically. By contrast, Visual Basic

provided easy-to-use debug facilities. PowerBuilder, with its lack of help and confusing

controls, ranked low.

BYTE Magazine

The article “Upgraded C/S Tools: How Much Better?” included Visual Basic, Delphi, and

PowerBuilder.  The article “New Leaders of the Client/Server” included Visual Basic, Delphi and

PowerBuilder.  The context of the articles could be summed up by the “Making a Choice” section in the

second article:

But good as {Visual Basic and PowerBuilder} are, Borland's Delphi takes top

honors. Developers will find its procedures for form design and accessing of

components similar to Visual Basic's, but in many little ways Delphi simply

makes it easier and more convenient to access data from a client/server database.

And its speed, both in database and non-database operations, is far ahead of all

the competition.
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Microsoft

Microsoft commissioned NSTL, Inc. to prepare an in-depth comparative evaluation of “Rapid

Application Development Tools” including: Visual Basic, Delphi, and PowerBuilder.  A qualitative

summary of their “Usability Results” would rank Visual Basic first, Delphi second, and PowerBuilder

third.

Sybase

Sybase provides a cursory comparison of Visual Basic and PowerBuilder in nine categories:

productivity, cross-platform support, skills availability and third-party support, general ease of use,

support for three-tier architectures, performance, Java support, size and complexity of applications, and

cost of deployment..  A qualitative ranking of their comparison gives Visual Basic four “strongs” and five

“weaks,” and gives PowerBuilder seven “strongs” and two “weaks.”

Borland

Borland commissioned Sphere Data Systems, Inc. to prepare an in-depth comparative evaluation

titled “A Comparison of Client/Server Development Tools; PowerBuilder vs. Delphi.”  The two products

were rated on performance, Rapid Application Development (RAD), database application architecture,

client and server tools, and user interface.  The paper concludes that “Delphi surpasses PowerBuilder 5.0

when it comes to performance, ease of use, object oriented technologies, database access, client/server

rapid application development, and scalabiltiy.”
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Symantec

Symantec does not provide any comparisons between itself and its competitors.  Symantec

announces that Visual Cafe offers excellent performance and features for new Java developers wanting a

RAD environment with client/server database support.

Development Tools Used for the Prototype

Back-End Tools

Two distinctive categories of database back-ends exits: “enterprise” and “local.”  Two of the

leading enterprise database tools are Informix and Oracle.  They are intended for storage and

manipulation of huge amounts of data.  Consequently, their implementation and maintenance require a

huge investment in time and money.

Local database back-ends, like Access, Paradox and dBase, primarily are intended for use by an

individual or a small group.  They are relatively inexpensive and easy to learn.  dBase was the first local

database to dominate the market.  dBase file formats (.dbf) are still the common denominator for sharing

data between databases.  However, the dBase commercial product essentially has become extinct. 

Microsoft Access has acquired major market share in recent years.

The applications for this project are intended for use by the UDOT Regions.  An enterprise back-

end, such as Informix, is not available locally at the Regions.  Besides, an enterprise back-end would be

over-kill for a project of this scope.  However, Access is available at both Region 1 and Region 2 — the

sites where prototypes would be guided and evaluated..  Therefore, Access was the back-end chosen for

the project.  Part way into the project UDOT requested dBase format files so data could conveniently be

imported to ArcView and other applications.  dBase format files then became the back-end data formats

for this project.
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Front-End Tools: 

As described in the previous section, the principal competing tools in the marketplace for front-

end development are Borland’s Delphi, Microsoft Visual Basic, Sybase PowerBuilder, and Symantec

Visual Cafe. All four currently are being used extensively in practice. Delphi was selected for the

following reasons:

• Visual Cafe was not chosen for several reasons, but primarily because it is specifically

tailored for Java applications, and Java was not required for this project.

• PowerBuilder has a strong user base that was built up in the past when PowerBuilder was

the best and most widely accepted front-end development tool for large scale client/server

applications. It is intended for use with large enterprise database systems such as

Informix. It is relatively expensive and has a long learning curve. It supports MS

Windows, Mac, and UNIX. It is not intended for development with local database back-

ends such as Access. It is not commonly used by university students, and is never used by

engineering students. PowerBuilder was not highly rated in the independent reviews.

• Visual Basic is emerging as a powerful visual development tool for client/server systems. 

It is relatively inexpensive and has a short learning curve. It can be used to develop front-

ends for enterprise database back-ends, such as Informix, as well as for local back-ends

such as Access. In addition, it is the basis for Visual Basic Application, the consistent

macro language for all Microsoft Office Products. It is the most prevalent computer

language currently being taught to engineering students. It only supports MS Windows. 

It was rated high in all independent reviews. Visual Basic is becoming a tempting

alternative for front-end development over a wide range of information systems

applications.

• Delphi has many of the same attributes as Visual Basic (VB).  VB is judged better in that

Delphi has a slightly longer learning curve and is not used by university engineering
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students. On the positive side, Delphi provides class structures similar to C++ and Java

that are not available in VB. Delphi was rated high in all independent reviews. Because

of its all-round performance capabilities, and its similarity to the C++ computer industry

standard, Delphi was selected for development of the front-ends for this project.
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PAVEMENT PRESERVATION PROTOTYPE

Background

Pavement Preservation currently is done in unison with paint preservation and the Maintenance

Management Quality Assurance (MMQA) program. The roads are divided into segments based on

beginning and end mile posts on a given route for a controlling station. All the pavement, paint and

MMQA attributes are keyed to these segments. Data is stored in sequential order in a Quattro-pro file.

The screen shot below captures part of that Quattro-pro file. As can be observed, data is entered in rows.

No structural separation exists between the pavement attributes and the paint attributes.

Figure 1.  Quattro Pro Spreadsheet Data Entry and Analysis Form
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Though pavement management using a spreadsheet brings with it advantages such as ease of use,

familiarity of personnel, it has several shortcomings which must be overcome. A few of those

shortcomings follow:

• Data, essentially spatial in nature, is not readily accessible to a spatial representation like

a GIS.

• Multi-user environment may lead to Data Redundancy (multiple copies of the same data).

• Difficult to consolidate data from multiple users.

• Data security not enforced rigidly.

• Not intended for large data sets.

• Difficult to query and filter data.

• Complex macro language that is difficult to maintain and debug.

• Merging data from several regions is awkward and prone to error.

A model was needed would overcome the aforementioned pitfalls and still maintain functionality

of the existing program.

Functionality for the Prototype

• Data Display: The prototype should allow easy display and access to records. Navigation

through the records of a database table should be in an efficient and user-friendly manner.

• Data Manipulation: Key data manipulation operations such as insert, update, and delete

should be easily facilitated by the model.

• Order of Information: Information is defined as “processed data.” The prototype must

allow for sorting data in an order defined by the user.

• Information Retrieval: Many a time, specific information must be retrieved from data.

The prototype should possess good querying abilities.
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• Data Storage: The format in which data is stored is an important issue. Data storage

should be in a form conducive for various development tools to access it.

•  Data Analysis: Data analysis is an offshoot of the previous need for standard data

storage. Data must be amenable for analysis using tools such as ArcView GIS.

Approach Adopted

This section details the approach adopted in meeting needs for the pavement preservation model. 

Data Standardization

The emphasis was on data standardization. All data were converted into the standard format.

Once data is in the standard format, migration to any other format becomes easy. Also database

development tools can access such data to perform various analysis and manipulation. dBase was chosen

as the standard platform as it is the generic database which can be accessed/ translated into any other

database with ease. dBase is a good fit in the architecture proposed, which calls for eventual transfer to an

enterprise database. dBase can be used with a base level database such as access or an enterprise system

such as SQL Server.

GIS Interoperability

All pavement management data is spatial in nature. Each of the road segments for which

attributes are stored corresponds to some specific geographic location. Keeping this fact in mind, the

prototype was developed to work well with a Geographic Information System. ArcView was the GIS tool

adopted. dBase tables are the standard format employed in ArcView. For this reason the pavement

management prototype is interoperable with ArcView.
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Determination of Data Structures

The pavement management database was organized into different topical modules. Therefore

there are tables dealing with data about pavement treatments, paint schedules, MMQA, pavement

evaluation and so on. Each of these tables has a mirror table for storing archived information. A list of the

tables and the fields contained in them is provided in Appendix A at the end of this report.

Data Entry and Manipulation

Specific input screens were developed for data entry and manipulation. These dialog boxes are

better than entering records in rows for the following reasons.

• Chances of data entry errors are minimized as the dialog box is focused on one record

and selected special fields.

• The user need not go over the whole row if only a few values are to be entered.

• Choice of values for certain attributes can be restricted by the use of drop-down boxes.

This ensures that the user does not input undesirable values.

• Access to these dialog boxes may be restricted, thereby increasing security.

Information Retrieval and Ordering

The prototype introduces improved querying and sorting capabilities as opposed to the

spreadsheet. Easy to use interfaces have been built which allow for data to be queried and sorted. Such

tasks would have involved cumbersome clipping and pasting in the original spreadsheet environment.
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PAVEMENT PRESERVATION MODEL EXAMPLE

This section deals with implementing the pavement management prototype to a real world

pavement preservation program. The emphasis is on illustrating the methodology and benefits accruing

by using this model.

Data Display

The opening screen shows the display of data already contained in the pavement table. Tools

have been provided to navigate through the record with ease. 

Figure 2.  Database Display of Data by Category.
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Data Manipulation

Pavement data is always dynamic. Records are to be updated constantly to keep track of surface

treatments and schedules. A history of such changes also must be maintained to provide an idea about

pavement durability and can be invaluable for various analysis such as life cycle analysis and benefit-cost

studies. This archiving facility was lacking in the spreadsheet model which is rectified in the prototype.

The tool for data manipulation brings up the following dialog box. The fields in the dialog box are

populated by values corresponding to the location of the cursor in the main form. Refer to the previous

screen shot to locate the cursor position. 

Figure 3.  Data Entry Dialog Box.
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Notice the drop down boxes for the treatment types. These will ensure that the user will only use

the specified treatment type, eliminating the possibility of an error. The post button on this form performs

two functions.

1) The main form (opening screen) gets updated showing the latest values, and

2) The old values are stored in an archive table which can be viewed conveniently as shown

in Figure 4.

Figure 4.  Display of Archived Data.

Ordering of Information

The prototype allows flexibility to order data depending on the constraints decided upon by the

user.  For example, the user might want to see all data grouped by the routes and see the last treatment

type as a sub-group. The order of sort can easily be defined by using the sort tool shown in Figure 5.  In

this example the user has designated a sort based on a primary field of “Route” and a secondary field of

“LST_TRE_YR” (last treatment type).

The results of the sort are shown in Figure 6. It shows the table sorted in the precedence of routes

and last treatment types. A sort also could be conducted on planned treatment years. This would give an
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idea of the tasks at hand and help in prioritizing. Thus, ordering of data is a useful tool in planning for

pavement treatments.

Figure 5.  Dialog Box for the Sort Tool 
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Figure 6.  Results of the Sort Based on the Parameters Specified in Figure 5.

Data Retrieval

Data Retrieval, as opposed to data sorting, is used to filter data.  Only those records that satisfy a

given condition are returned. Complex queries can be performed using this model. For instance, the user

might want to see all the segments due to be treated in 1999 and due to occur on route 15. The query tool

is put to use in such cases.
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Figure 7.  The Dialog Box for the Query Tool.

Figure 8.  Results of the Query Based on the Parameters Shown in Figure 7.

Data Analysis

Analysis and graphic display of pavement data can be efficiently performed using a GIS tool such

as ArcView. The single biggest advantage of a GIS is that it lets the user visualize information in new

ways that reveal relationships, patterns, and trends that would otherwise be intangible in a tabular system.
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UDOT’s pavement data was analyzed using ArcView.  Numerous demonstrations of its power were made

at UDOT seminars. The following series of screen shots show how GIS can be integrated with the

pavement preservation model.

Figure 9. shows the GIS display of the road segments maintained by Region 2 in dark black. Utah

State Highways are shown in gray.

Figure 9. GIS Display Showing State Routes in Region 2.
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Figure 10. This screen highlights roads that are due for surface treatments in the year 2000. These

roads are shown in thicker lines. In this way, at a glance the manager can tell which roads are due for

treatment planned for the year 2000, and can further prioritize tasks and schedule work among the

maintenance crews.

Figure 10.  GIS Display of Surface Treatments Planned for the Year 2000.
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PAINT PRESERVATION MODEL EXAMPLE

The Paint Preservation Model (PAINT) is similar to the Pavement Preservation Model (PAVE).

Data are stored in a standard format. This makes the Paint preservation model readily amenable to a GIS

analysis. Specific data manipulation dialog boxes have been built to provide the user with an easy

interface. The following series of screen shots summarize the paint preservation model.

Figure 11 shows the PAINT database. Customary tools have been provided for navigating

through the records.

Figure 11. Input Dialog Box for Manipulating the Paint Data.
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Figure 12.  Dialog Box for Inputting Data to the PAINT Database.

The PAINT database also has the following features:

• auto archiving on post

• ability to perform multiple sorts on the database

• ability to query the paint database

• ability to generate tables derived from the main database. Refer to the user’s manual

section.

The PAINT database also can be analyzed using a GIS as shown in the following exhibits. 

Figure 13 displays the roads in Region 2 graded by the different paint types.

The database and GIS analysis also can be used to create charts and graphs as shown in Figures

14 and 15.
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Figure 13.  GIS Display of Paint Types in Region 2.

Figure 14. Graphic Display of the Paint Profile Planned for the Year 2000.
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Figure 15.  Graphic Display of the Miles of Paint Applied by Year.

Figure 15 is a graphic of the miles of paint planned for application by year.  The values have been

computed from the database, and the results are shown in the form of a bar chart.

Figure 16 is a graphic displaying the power of GIS to relate data from disparate databases and

perform an analysis. Here the single dashed lines are pavements scheduled for painting in the year 2000.

The double lines are pavements scheduled for treatment during years 2001 and 2002. The overlap of these

lines show pavements which will be treated within two years after striping.
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Figure 16.  GIS Display of Pavement Overlays and Pavement Striping.
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MAINTENANCE MANAGEMENT QUALITY ASSURANCE EXAMPLE

Introduction

Each Region and Station is responsible for assessing the quality of its roads. This Maintenance

Management Quality Assurance (MMQA) process is accomplished by randomly selecting segments of

roads, visually inspecting the segments, and grading the results on a scorecard.  The scorecard is divided

into 10 groups:

1) snow removal

2) hard surface maintenance

3) non-hard surface maintenance

4) roadside maintenance

5) vegetation control

6) drainage and slope repair

7) major structure maintenance

8) traffic services

9) supervision, training, and support maintenance

10) rest area maintenance

Each group contains several activities.  Performance measures are specified for each activity.  Scoring is

accomplished by rating the performance measure for each activity on a scale from Av(high) to F (low). A

complete list of groups, activities, and performance measures is presented in Appendix C.

UDOT developed a Quatro Pro spreadsheet to help station personal conduct scoring in the field. 

The spreadsheet generates random numbers for selecting road segments, and provides dialog boxes for

scoring each activity.
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Region 2 added columns to their Pavement Preservation spreadsheet in an attempt to consolidate

Pavement Preservation, Paint Preservation, and Maintenance Management Quality Assurance into a

unified software suite that could be used by the regions.

The objective of this part of the project was to demonstrate an alternative to the spreadsheet, and

to present some of its advantages including interaction with Geographic Information Systems (GIS).

Database Approach

The dialogue boxes of MMQA data can easily be replicated in dBase using standard tools.  Figure

17 is the highest level dialog box showing the general information and the randomly selected route

segments in the spreadsheet.  The main advantages of dBase files over spreadsheets are as follows:

Accessability to Data

The dbase files can easily be linked with ArcView GIS. Numerical data can be viewed in two

dimensions.  A two-dimensional picture gives a detailed overview of the data which can be  useful to the

people in the field.  The database format reduces the time and effort needed to generate a geographical

display showing the spacial distribution of the scorecard values.  Figure 18 shows the region on the

standard state highway reference system.

Analysis of Sata Made Easy

With the two dimensional/route map available in ArcView, the data can be analyzed further,

which will give a detailed output. Any type of analysis can be made on the data and any number of

additional attributes can be linked with the data available. For example, the attribute length of route can

be added to make the tables more self-explanatory. Also one can make an analysis such as which part of

the county has maximum traffic or which part of routes require MMQA treatment and so on. These

analyses make the data more useful and efficient. This also could save some time and effort of the site
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engineers who go out to collect the data which can be evaluated on the desk by conducting analysis in

ArcView. Some of the analysis done on MMQA is shown in Figures 19 through 22.
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Figure 17.  Dialog Box Showing Randomly Selected Route Segments

Figure 18.  Sites for MMQA Data for Region 2.
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Figure 19.  Display of MMQA Data Field “Asphaltholes”.

Figure 19 shows ratings for the MMQA parameter “Asphaltholes” on the State Highway Route

map.  This type of information is useful for prioritizing and scheduling.  Figure 20 shows information

from Figure 19 plus a character (A through F, or N/A) representation of the score for the respective route

segment.  

Figure 21 shows similar data for the MMQA parameter “Concreteholes” plotted as bars.
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Figure 20.  Display of MMQA Data Field “Asphaltholes” Showing Character Score.

Figure 21.  Display of MMQA Data Field “Concreteholes”.
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Figure 22.  Table of Attributes Displayed by the Identity Tool.

Data Queries

The simplest way to access data is to use the GIS Identity Tool.   As shown in Figure 22, the

identity tool in ArcView gives all the attribute information on screen for any route selected.  Again this is

an efficient and handy tool for the site engineers.
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The query tool is the main tool used to answer most of the questions during analysis. For example

in Figure 23 and 24, with the help of this tool one can find a particular route or all MMQA treatments

required in a particular year. Multiple queries using Boolean values, like “and,” “or,” “>,” “<,” etc; can be

used where more than one attributes is to be used to find an accurate solution.

Figure 23.  Multiple Query Tool.
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Figure 24.  Display of Query Results.

Statistics 

Statistics of the data are essential for most planning studies.  With the database front end or a GIS

like ArcView, tools are readily available to calculate statistical parameters such as standard deviation,

mean, sum, count, maximum value, minimum value, variation, etc. Figure 25 shows the sum, count,

mean, maximum, minimum, range, variance, and standard deviation for the shaded data.
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Figure 25. Statistical Summary for Selected MMQA Data
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CONCLUSIONS

The pavement inventory and scheduling needs assessment at the regional level provided the

information for developing a computer-based tool that could be applied at the local level.  The needs at

headquarters for aggregating the data were accommodated by exposing the regional data in standard

(.dbf) formats.

A variety of development tools were considered for the project including: Borland Delphi,

Microsoft Visual Basic, Sybase PowerBuilder, and Symantec Visual Cafe.  Each of these tools has its

strong and weak points.  After careful consideration, Delphi was selected.  We judged that it provides

satisfactory connectivity for enterprise as well as local back-ends, it provides a powerful development

language (object Pascal) for engineering algorithms, and it provides an exceptionally good Integrated

Developers Environment (IDE).

The Pavement Preservation Prototype consists of three coordinated sections: Pavement

Treatments, Paint Treatments, and Maintenance Management Quality Assurance.  Each section was

provided with a customized Graphical User Interface (GUI) in conjunction with a standard database back-

end.  The GUIs were designed to resemble as closely as possible the forms that were currently in use in

order to reduce the impact of switching to a new system.

Because the data were converted and exposed in a standard format, straight forward ArcView GIS

analyses could be applied.  Examples are provided for each of the three prototype sections demonstrating

the advantages of standardizing regional data and applying GIS for analysis and visual displays.
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APPENDIX A

DATABASE TECHNICAL DETAILS
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GENERAL DATABASE    

Field name Type 

STATION Number

ROUTE Number

BEGIN_MP Number

END_MP Number

LOCATION Char

ADT_1997 Number

SURF_AREA Number

LAST_CONST Char

ROAD_CLASS Char

STIP Char

LANE_MILES Number
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PAVEMENT DATABASE

Field name Type 

STATION Number

ROUTE Number

BEGIN_MP Number

END_MP Number

LST_TRE_TY Char

LST_TRE_YR Number

SCD_TRE_TY Char

SCD_TRE_YR Number

PLN_TRE_TY Char

PLN_TRE_YR Number

LANE_MILES Char
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PAINT DATABASE

Field name Type 

STATION Number

ROUTE Number

BEGIN_MP Number

END_MP Number

LST_PT_TYP Char

LST_PT_YR Number

SCD_PT_TYP Char

SCD_PT_YR Number

ACT_PT_TYP Char

ACT_PT_YR Number

LANE_MILES Char
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EVALUATION DATABASE

Field name Type 

STATION Nmber

ROUTE Number

BEGIN_MP Number

END_MP Number

EVALUATION Char

CRACK_IND Number

IRI Number

RUT_DEPTH Number

SKID_NUMBER Number

COMMENTS Char
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MMQA DATABASE

Field name Type 

STATION Number

ROUTE Number

BEGIN_MP Number

END_MP Number

ASPH_HOLES Char

ASPH_CRACK Char

CONC_HOLES Char

SHOULD_EDG Char

LITTER_AMT Char

ROCK_DEBRI Char

WEED_CONTR Char

VEG_CONTRL Char

MOWING Char

LANDSCAPE Char

DRAIN_CLEA Char

DRAIN_INLE Char

SLOPE_RE Char

BRIDG_DECK Char

BRIDG_STRU Char

BRIDG_JOIN Char

PAVE_STRIP Char
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PAVE_SYMBO Char

SIGNS Char

DELINEATOR Char

GUARDRAIL Char

H/W_LIGHT Char

SIGN_REPA Char

SWEEPING Char

GUTER_ISLAND Char
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APPENDIX B

USER’S GUIDE
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USER’S GUIDE TO THE PAVEMENT DATA INTERFACE PROGRAM

Introduction

The Pavement data interface program is an efficient tool for the collection, analysis and retrieval

of data. It consists of several components that are tailor made to suit the current requirements of UDOT

pavement data management. 

The program has been modeled after the Quattro-pro spreadsheet programs that are currently

being used. While mirroring the ease-of-use of a spreadsheet, this program has additional advantages. The

database structure developed is used to perform repeated tasks such as querying and sorting with ease. A

GIS tool such as ArcView can access the tables stored in this program. This provides a real time spatial

representation of the pavement data.

Salient Features

The first command to be executed on running the program is the File > Open menu. This leads

the user to the directories on the machine. The user needs to select the correct path the database resides in

and click on any of the tables.

The opening screen shot shows the five different databases which can then be viewed

individually by clicking on the tabs. 
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A navigator tool has been provided which allows convenient access to each of the rows in the

database. The buttons have the following functionality.

       Moves the cursor to the first row

Moves to the prior row

Moves to the next row.

Moves the cursor to the last row.

The File > Print command prints the table being viewed.

The File > Close command exits the program.

The Edit menu brings up a new dialog box which is used to update the databases. The values of

the fields of the row pointed by the cursor are seen in the dialog boxes. A typical dialog box would

resemble the following screen shot.



53



54

Once the requisite changes have been made, the user has a choice of posting the changes or

canceling them.

The following occurs when the ‘Post’ button is clicked

(a) The record in the main table gets updates with changes made in the dialog box.

(b) The changed record gets archived in a separate archive table.

This two-step approach to updates ensures that a record of all changes made is maintained.

The Add menu items work similar to the Edit menu items with the difference that the Add

commands are invoked when adding a new road segment. A dialog box similar to the edit dialog pops up

which can be populated with the new values.

The Tools > Archives command enables one to view the archived tables. A print option is also

included. Navigation tools have been provided to move through the database. Additionally a tool to delete

records has also been provided to clean up the archived table.

The Tools > Queries tool allows one to query the database. Complex queries are supported by

this program using the ‘and’ or ‘or’clauses. This tool brings up the following screen.
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The following sequence of commands has to be followed to query the database.

(a) The table to be queried should be chosen in the drop-down box. In this example, we have chosen the

‘Paint’ table.

(b) The fields available for the table chosen show up as a list on the left-hand side.  The user double-

clicks the field to be queried.

(c) The user single-clicks the operand to set the query.

(d) A list of values available is displayed as a list in the right-hand side. The user double-clicks on the

value he needs selected.

(e) The query as chosen appears on a box below the lists (in the example here; “Route =15”). 

(f) Clicking on the ‘Go’ button brings up the query results.

(g) Clicking on the ‘Clear’ button resets the query.
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The results of a query can be printed or saved as a new table as shown in the next screen shot.

The Tools > Sort command is used for multiple sorts on the database. The screen looks like the following

graphic.
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The following steps are to be followed:

(a) The table, which needs to be sorted, is chosen first.

(b) The source list details all the available fields. Using the right arrow (>), the destination list can be

populated in the order of precedence. The up and down arrows can also be used to determine the sort

order. The double-right arrow (>>) can be used to transfer the entire source list to the destination.

(c) The ‘OK’ button gives the sorted table which can be printed and saved as a new table.
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The Print command on all these screens lead to the following dialog box. 

The print tool contains standard features such as zooming the preview, setting up the paper size and

properties such as landscape and portrait. All these dialogues are in the standard windows format.
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APPENDIX C

MMQA DATA DESCRIPTIONS
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